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Structure 

Introduction 
The Taskmaster Window supplies an authorized user with two supervisory tools: 

• The Job Monitor (Page 4) is a comprehensive guide to an application’s batch 
processing activity. It is also a powerful device Administrators and Supervisors 
can use to initiate and manage a workflow’s Job/Task Combinations. Multiple 
Job Monitors can be set up and administered by an application’s Job Monitor 
Manager (Page 60). 

• The Station Monitor (Page 53) tracks the processing activity of workstations on 
which Taskmaster Clients reside, and of the users (operators, Supervisors and 
Administrators) who are working from these workstations. 

A principal focus of both tools is this data triad: 

Job. A job is a processing unit with a single objective and a set of tasks to 
accomplish that objective. A “Main” job first scans a page and its data, then 
recognizes and verifies the data.  The job closes by adding the data to an Export file 
or database. Although Main jobs are the backbone of most workflows, they are often 
assisted by special-purpose, remedial child jobs.  In addition, most applications have 
a “Demo” job that starts off with a “virtual” scanning task. Because this task 
processes images rather than paper, the Demo job runs swiftly and is an excellent 
testing and training tool. 

Task. A task is a procedure designed to accomplish one phase of the job’s overall 
objective. Once a task has been formally defined, it is assigned to a job: in fact, a task 
cannot carry out its work unless it is part of a job. To be precise, therefore, the 
workflow’s processing unit is not a task alone but a Job/Task Combination. The 
Job/Task Combination is Taskmaster’s fundamental processing entity. 

Batch. A batch is the processing vehicle that conveys the images and data of a 
document’s pages from task to task until the job is finished. A batch is created by the 
Scan task at the beginning of the workflow; its contents grow as it moves from task 
to task.  

This information comes together in the form of a Batch Transaction Record which links 
a specific batch to a particular Job/Task Combination. For details of the Batch 
Transaction Record, see Page 6. 

9 Chapter 6 of the Guide to Taskmaster Rules explains the nature and components of a 
batch, and shows you what happens when the batch moves from one task in a job to the 
next – and even back and forth between a parent job and a child job. 

9 The Station Monitor and Job Monitor are tools of the Taskmaster Window. Chapter 3 
fully explains all aspects of this essential window and its environment.   
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Taskmaster Window – with Job Monitor 

 

 
Taskmaster Window - with Station Monitor 
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Structure 

Job Monitor 
Taskmaster’s Job Monitor continuously generates up-to-the minute batch processing 
information, and gives you tools you can use to isolate, diagnose and solve problems.  

9 To access the Job Monitor, select Job Monitor from the View menu, or click on its icon 
in the Taskmaster Window toolbar. 

( Alert! Because of the nature of its data and procedures, the Security Programs of most 
applications (Chapter 6) limit access to the Job Monitor to Administrators and 
Supervisors.  
 

           Job 
           Monitor 

           Toolbar 
           icons 

            Menus 
Batch         
Information 
Table
 
Taskmaster Window–with Job Monitor 

As you can see in the example above, the rows and columns of the Batch Information 
Table form the central component of the Job Monitor. The majority of other 
components, including menu items and toolbar icons, assist or expand the Batch 
Information Table – and, if appropriate, allow an Administrator or Supervisor to initiate a 
listing’s Job-Task activity. 

Before examining the details of individual components of the Job Monitor, spend a 
moment with its overall structure. 
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Structure 
The Job Monitor has these features: 

Title Bar. The Title bar identifies the window. It can also specify a Refresh 
Rate…just how often Taskmaster regularly updates the Batch Information Table. 
(For more about the Refresh Rate, see Page 21.) 

 

Batch Information Table.  Each row in this table identifies a batch that is: waiting 
to be processed by a specific Job/Task Combination; in a temporary holding position; 
or no longer the object of the job’s attention. The data for each listing spreads across 
14 default columns; a full explanation of these columns begins below. In addition, 
Taskmaster helps you define and install custom columns: Page 49 investigates this 
procedure.   

Status Bar. The Status bar identifies the row of a listing you’ve highlighted.  

Menus. When the Job Monitor is active, the menus of the Taskmaster Window serve 
the Job Monitor exclusively. Page 12 describes the items in these menus. 

Toolbar icons. When the Job Monitor is the active component of the Taskmaster 
Window, the icons in the toolbar are dedicated to the Job Monitor. Page 19 reviews 
the role of each icon. 

Window Aids. Clicking once on the icon at the left end of the Title bar reveals a 
mini-menu with aids to help you with the window itself. Buttons at the right end of 
the Title bar duplicate the actions of four menu items: Minimize, Maximize, Restore 
and Close (the Restore button appears only if you minimize the Job Monitor.) 
Selecting Move lets you move the Job Monitor around the Data Area of the 
Taskmaster Window but using your cursor to drag it is easier and just as effective. If 
multiple secondary windows are open in the Data Area of the Taskmaster Window, 
selecting the Next item brings the “next” window to the foreground. 

Navigational Aids.  Scroll bars along the Job Monitor’s lower and right edges move 
you quickly column to the column and row to row within the Batch Information 
Table. In addition, action arrows within the Status bar move you from row to row, or 
to the first row or to the last row. Items in the Record menu duplicate these actions. 

Supervision. The Job Monitor Manager has administrative responsibility for the 
single Job Monitor you use – and for all additional monitors. Page 60 explains the 
features of the Job Monitor Manager.   
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Batch Information Table 

Batch Information Table 
A portion of the Batch Information Table is illustrated below. You can use standard 
formatting tools to modify the table’s appearance (Page 55). The Job Monitor’s Filter 
mechanism can expand or contract its content according to parameters you provide (Page 
23). 

Descriptions of the table’s fourteen default columns begin on the next page. For each 
row, the information in these columns combines to form a single Batch Transaction 
Record. Again, the data in three columns provides the record with its primary focus: 

• Batch ID. This is the identifying code provided by the Scan task when it created 
the batch (Chapter 4). 

• Job.Task. Usually, this is the Job/Task Combination next in line to process the 
batch. However, if the status of the batch is Aborted or Hold, or Done, this 
column lists the Job/Task Combination that produced the status. 

• Status. This column indicates the current processing status of the batch. 
 

 
Job Monitor– 

Batch Information Table (left columns) 
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The columns of the Batch Information Table include: 

Column Description 

<Record ID> The number of a row in the table; also the Record ID for a 
specific Batch Transaction Record.  

This row number also appears in the Status bar’s Record ID 
field.   

Taskmaster adds new Batch Transaction Records to the bottom 
of the list. If you delete a listing (Page 46), the lower listings 
move up a row.  

Alert! If you double-click on a Record ID, Taskmaster 
highlights the listing and launches its Job/Task Combination if 
the processing Status of the batch is appropriate (Pending, for 
example). 

Q ID A number indicating the position of the batch within the 
Taskmaster processing queue. 

Taskmaster assigns a Queue ID to a batch when the Scan task 
first assembles it: in general, lower numbers indicate earlier 
batches. The position of the batch within this overall queue, 
along with its Priority and current Status, determine its order 
within the processing queue of a specific Operations window 
Job-Task shortcut (Chapter 4 and Chapter 6). 

A Queue ID remains with the batch throughout each phase of its 
involvement with a specific job. Taskmaster might assign Batch 
20040200.004 to two queues – one queue for a parent Main 
job’s Recognition task, the other for a FixUp child job’s FixUp 
task. 

Alert! If you double-click on a Queue ID, Taskmaster launches 
the Job/Task Combination if the processing Status of the 
batch is appropriate (Pending, for example). 
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 Batch Information Table (continued)  
Column Description 

Batch ID The unique identifying code assigned to the batch, usually by 
the Scan task (Chapter 4). 

Alert! If a Batch ID such as 20020200.004 were to appear not 
only in Record 10 but in Record 13 as well, the apparent 
duplication would occur because the Recognition task of the 
Main Job (Main Job.Recognize) had problems with one or more 
pages in the batch.  

In this case, Recognition temporarily halted its work with the 
batch, forwarded it to the FixUp job’s FixUp task 
(FixUp.FixUp), and gave the batch a Waiting status.  From the 
perspective of the FixUp child job (and its FixUp task), the 
batch is now in its queue and has a Pending status. 

Double-clicking on a Batch ID retrieves the Batch Attributes 
dialog (Page 34). 

Job.Task The name of a job and the task assigned to the job. 

Taskmaster’s indication of a Job/Task Combination depends on 
the location of the batch within the workflow and on its status. 

Typically, a Job Done status indicates that the final task in a job 
has successfully processed the batch. In contrast, a batch with a 
Pending or Waiting status awaits processing. 

Alert! A record with a Job Done status will remain in the Batch 
Information Table until an Administrator deletes it. 

Double-clicking on a Job/Task Combination retrieves the Batch 
History dialog (Page 36). 
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Job Monitor–Batch Information Table (left columns)  

 Batch Information Table (continued)  
Column Description 

Status The current processing status of a batch, and a key element of 
its record. (For definitions of each status, see Page 30.) 

Most tasks in the workflow cannot process a batch unless it has 
an acceptable status–a status such as Hold or Pending.  To 
return an Aborted batch to the workflow, an Administrator must 
first change this status. 

Double-clicking on a status retrieves the Status 
Change/Rollback dialog (Page 30). You can use this dialog to 
change the status of the listing’s batch, or to “roll back” the 
batch to an earlier Job/Task Combination.   

Job Start The Date and Time when the job in the Job.Task column began 
working with the batch. 

For a Main job, this is the point at which the Scan task 
assembles the batch. In the case of a child job, however, this is 
the moment when the child job’s first task began processing the 
batch. 

JSec The cumulative time, in seconds, that the job’s tasks have spent 
on the batch so far. 
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 Batch Information Table (continued)  
Column Description 

Task  Start The Date and Time when the task of the record’s Job/Task 
Combination began processing the batch.  

This column includes values only if the task has spent time with 
the batch. If the batch is awaiting the attention of this task – or 
the task of a child job - there is no entry. 

TSec The cumulative time, in seconds, that the task component of the 
Job/Task Combination has spent on the batch so far. 

Again, this column contains a figure only if the task has been 
involved with the batch. 

Op The User ID of the operator or Administrator who must process 
this batch. 

This column contains an entry only if the Task Definition of the 
preceding task has a Store value of User or User and Station, 
and the Queue to value of the current task is Same User, or 
Same Station and Same User. Chapter 6 and Taskmaster Help 
explain these values. 

Alert! Double-clicking in this field opens the Change 
Operator/Station/Priority dialog (Page 37). 

Station The Station ID of the workstation which must process this 
batch. 

This column contains an entry only if the Station Definition of 
the preceding task has a Store value of Station or User and 
Station, and the Queue to value of the current task is Same 
Station, or Same Station and Same User (Chapter 6). 

Double-clicking in this field opens the Change 
Operator/Station/Priority dialog (Page 37). 

Pr The Priority value assigned to the batch as a job-level default 
(Chapter 6). 

Double-clicking in this field opens the Change 
Operator/Station/Priority dialog (Page 37). 

Docs The number of documents currently in the batch. 

Alert! This number changes at discrete points in the workflow. 

Images The number of Image files in the batch. 

This number should not change as the batch moves from task to 
task unless the Administrator authorizes the deletion of an 
Image file. 
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Job Monitor–Batch Information Table 

 (right columns) 

 
( These are the default columns of the Job Monitor’s Batch Information Table, arrayed in 

a default format. As Administrator, you can add columns (Page 49) but cannot remove a 
column. You can also change the way the Batch Information Table appears when it 
shows up on a user’s screen (Page 55). 

Remember, too, the close relationship between the Job Monitor and the Batch Selection 
dialog (Chapter 4): a change to one results in an identical change to the other. 
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Menus of the Job Monitor 
The Job Monitor, when it is the active component of the Taskmaster Window, employs 
the menus you see in the illustration below. 

File Menu 

 
File Menu – Job Monitor 

Item Accelerator Keys Description 

Message Font n/a Accesses the Windows Font Selection dialog. 

You can use this dialog to modify the Message 
Pad’s font, type size and format. 

Printing Items  The menu items in this area help you format and 
print the contents of the Batch Information Table.  

   Print Ctrl + P Prints selected pages of the Batch Information 
Table, or the full table. 

Alert!  The table’s width usually requires two 
printed pages to capture the data in all fourteen 
columns. However, the Job Monitor’s formatting 
options help customize the scope and presentation 
of this data. For details, see Page 57. 

   Print Preview n/a Accesses Taskmaster’s Print Preview dialog. 

This dialog offers various views of the pages you’re 
going to print, at various magnifications…as well as 
directs links to the printing process. This is a handy 
tool: don’t overlook it.  For more, see Page 57. 
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File Menu –active Job Monitor (continued)  

Item Accelerator 
Keys 

Description 

   Print Setup n/a Leads you to a Print Setup dialog that closely resembles 
the Windows Print dialog. 

One important difference: You’ll use this dialog to 
specify Portrait or Landscape as the Page Layout. 

   Page Setup n/a A specialized formatting tool you can use to design, test 
and implement alternative reporting structures for the 
Job Monitor’s Batch Information Table (and for the 
Station Monitor’s Station Information Table).  

For a full explanation, see Page 57. 

  Header/Footer n/a Accesses the Header/Footer dialog. 

You can use the settings in this dialog to specify the 
titles, page numbers, etc. that are to appear in the 
“header” or “footer” portion of each page of a report. For 
details, see Page 57. 

Exit n/a Closes the Taskmaster Window. 

 

View Menu 

Item Keyboard Description 

Customize n/a Accesses the Customize Toolbar dialog. 

The settings in this dialog determine the configuration of 
the Taskmaster Window toolbar when the Job Monitor 
is active, and the makeup of any secondary toolbars. 

For more information about toolbar assembly, see 
Chapter 3. 

Status Bar n/a Toggles the Taskmaster Window’s Status bar On and 
Off (Chapter 3). 

Operations Ctrl + O Accesses the Operations window (Chapter 4). 

The    icon duplicates this action. 

Job Monitor Ctrl + J Unavailable when the Job Monitor is active. 

Station Monitor Ctrl + S Accesses the Station Monitor (if you are operating in a 
client/server mode.) 
 

The   icon duplicates this action. 
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View menu – Job Monitor  

 View Menu – active Job Monitor (continued)  
Item Keyboard Description 

Job Monitor 
Manager 

n/a Accesses the Job Monitor Manager – a supervisory  dialog 
responsible for the setup and content of an application’s 
Job Monitor(s). For details, see Page 60. 

Zoom In  n/a Increases the magnification of rows in the Batch 
Information Table.  

The    icon duplicates this action. For more about 
formatting options, see Page 55. 

Zoom Out  Decreases the magnification of rows in the Batch 
Information Table. 

The    icon duplicates this action.  

100% n/a Displays the data in the Batch Information Table at the 
table’s standard font size. 

The    icon duplicates this action.  
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 View Menu – active Job Monitor (continued)  
Item Keyboard Description 

Freeze Columns n/a “Freezes” one or more columns you highlight in the Batch 
Information Table. 

Freezing moves a column (and all its cells) to the left edge 
of the Batch Information Table, making it the first column 
in the table. If you freeze multiple columns, they take 
positions on the left side according to their relative 
“unfrozen” positions. 

Freezing also ensures that the column remains in view: as 
you scroll to the right, other columns will disappear behind 
this column. 

You can freeze a single column or multiple, contiguous 
columns. 

This is a very helpful tool: be sure to experiment with it 
freely as you learn to work with Job Monitor and its Batch 
Information Table. 

Unfreeze 
Columns 

n/a Removes columns from a frozen state and returns them to 
their proper locations within the table. 

Freeze Rows n/a Freezes one or more Batch Transaction Records you’ve 
highlighted. 

Freezing moves the rows containing these records to the top 
of the table and ensures that they remain in sight as you 
scroll downward through the table. 

Although you can freeze multiple records as a group, you 
can only freeze one group at a time. 

Unfreeze Rows n/a Removes records from their frozen state and returns them to 
their original location in the table. 

Filter Ctrl + R Accesses the Job Monitor’s Filtering mechanism and the 
corresponding Filter dialog. 

In a high-volume operation, the Job Monitor steadily, adds 
listings to the Batch Information Table. Filtering uses 
selection parameters you provide to limit the display of 
batch data. For a full explanation, see Page 23. 

The      icon duplicates this action. 
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 View menu – active Job Monitor (continued)  
Item Keyboard Description 

New Monitor n/a Introduces a second Job Monitor into the Data Area 
of the Taskmaster Window. 

With two Job Monitors open, you can take advantage 
of the Filtering mechanism to view different lists of 
Batch Transaction Records almost simultaneously. 
This is a convenient and almost instant procedure. 
However, we strongly recommend that you use the 
Job Monitor Manager instead, because of its 
additional scope (Page 60). 

Find Ctrl + F Accesses the Taskmaster Find dialog. 

You can use this dialog to search the Job Monitor’s 
Batch Information Table for a specific listing (Page 
44).  

Find Again F3 Conducts a second search using the most recent 
criteria you entered in the fields of the Find dialog.  

 
 

 
Record Menu – Job Monitor  

Page 5–16 Confidential and Proprietary Information of Datacap Inc. 
 Copyright © 2005 Datacap Inc. 



Chapter 5: Job Monitor and Station Monitor 

Record Menu 

Item Keyboard Description 

Execute Ctrl + E Launches the listing’s Job/Task Combination if the 
processing Status of the batch is acceptable.  

You can double-click on the listing’s Record ID or 
Queue ID to initiate the same procedure. 

Status 
Change/Rollback 

Ctrl + R Accesses the Status Change/Rollback dialog for a 
listing you’ve highlighted (Page 30). 

This dialog also appears if you double-click on the 
listing’s Status field. 

Change Properties Ctrl + P Accesses the Change Operator/Station/Priority 
dialog for a listing you’ve highlighted (Page 37). 

You can also double-click on the listing’s Op field,  
Pr field, or Station field to retrieve this dialog. 

Batch Attributes Ctrl + B Accesses the Batch Attributes dialog for the listing 
you’ve highlighted (Page 37). 

You can also double-click on the listing’s Batch ID to 
retrieve this dialog. 

Batch History Ctrl + H Accesses the Batch History dialog for the batch 
you’ve highlighted.  

You can also double-click on the listing’s Job.Task 
specification to retrieve this dialog. 

Change Custom Field 
Properties 

Ctrl + M Opens the Custom Field Properties dialog for a 
“custom” field in the listing if you have added a 
“custom” column to the Batch Information Table 
(Page 49). 

To enter data into the field, an authorized user must 
access this dialog. You can also reach it by double-
clicking on the field itself.  

Delete Del After a series of warnings, deletes the listing from the 
Batch Information Table and, if appropriate, the batch 
and all its contents. 

Alert! This is an extreme measure – usually, a 
“privilege” granted to Administrators and Supervisors 
only (Chapter 6). 

New Batch, Execute 
Pending Batches, 
Cancel Batch Selection 
Mode 

n/a The options in this section are available only when the 
Batch Selection dialog rather than the Job Monitor    
is the active component of the Taskmaster Window 
(Chapter 4.) 
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Record menu – active Job Monitor (continued)  
Item Keyboard Description 

First Record n/a Moves your cursor to the table’s first Batch Transaction 
Record. 

Previous Record n/a Moves your cursor to the listing above the current record. 

Next Record  n/a Moves your cursor to the listing below. 

Last Record n/a Moves your cursor to the Batch Transaction Record at the 
bottom of the table. 

Update View n/a Instantly updates the Batch Information Table. 

The    toolbar icon duplicates this action. 

Change 
Timeout 

n/a Accesses the Change Timeout dialog. 

You can use this dialog to modify the timing of updates to 
the Batch Information Table (Page 21). 

The     icon duplicates this action.   
 

Settings and Database Menus 

The items in these menus are administrative but have no direct relationship to the Job 
Monitor. The Settings menu retrieves the tabs of the Taskmaster Administrator (Chapter 
6), while the Database menu gives the Administrator additional tools to test user access 
to an application’s Admin and Engine databases (Chapter 3).  

Tools Menu 

The items in this menu are administrative aids covered in Chapter 3.  

Window and Help Menus 

These menus contain standard Windows items and Help retrieval selections. 
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Toolbar Icons of the Job Monitor 
In the 1040EZ training application, the toolbar of the Taskmaster Window contains 
numerous icons when the Job Monitor is the active component of its Data Area.  
 

 

        Toolbar 

 
Two are core icons of the Job Monitor (Chapter 3). The icon on the left in the illustration 
below accesses the Job Monitor Filter (Page 23), while the icon on the right opens a 
second Job Monitor inside the Taskmaster Window’s Data Area. 
 

 
Core Icons–Job Monitor 

The core icons are joined by five icons from the Monitor group…icons shared by the 
Job Monitor and Station Monitor, and by the Batch Selection dialog (Chapter 4). On the 
left, the Refresh icon instantly updates the Batch Information Table. The clock next to it 
accesses the Change Timeout dialog (Page 21). On the right are three magnification 
tools; they duplicate the View menu’s Zoom In, Zoom Out and 100% items: 
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Toolbar Icons of the Job Monitor 

 
Monitor Icons 

Icons in Taskmaster’s File category fill out this toolbar configuration. The table below 
describes the role of each icon essential to the Job Monitor’s operations. 

Title Icon Menu Item? Description 

Operations 
 

View/Operations
(Ctrl + O) 

Accesses the Operations window (Chapter 4).  

Station 
Monitor  

View/Station 
Monitor  
(Ctrl + S) 

Accesses the Station Monitor (Page 49). 

Refresh 
 

Record/  
Update View 

Updates the Batch Information Table. 

Change 
Timeout  

Record/  
Change Timeout 

Accesses the Change Timeout dialog. 

You can use this dialog to change the amount of time 
between automatic updates to the Batch Information Table 
(Page 21). 

Filter 
 

View/Filter 
(Ctrl + R) 

Accesses the Job Monitor Filter. 

By providing the filter with search and selection criteria, 
you can limit the scope of the Batch Information Table’s 
listings (Page 23). 

Second Job 
Monitor  

View/New 
Monitor 

Places an auxiliary Job Monitor in the Data Area of the 
Taskmaster Window. 

Zoom In 
 

View/Zoom In Increases the magnification of the Batch Information Table. 

Zoom Out 
 

View/Zoom Out Decreases the magnification of the Batch Information Table. 

100% 
 

View/ 100% Returns the default magnification. 

Settings 
 

Settings Accesses the tabs of the Taskmaster Administrator 
(Chapter 6). 

General 
 

Settings/General Retrieves the three tabs of the Taskmaster Settings dialog 
(Chapter 3). 

Run Task 
 

Database/Run 
Task 

Accesses the Run Task dialog (Chapter 3). 

Administrators use this dialog to test a new or modified 
application or workflow configuration. 
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Refreshing Batch Information 
Taskmaster automatically updates the Job Monitor’s Batch Information Table every x 
minutes, y seconds. 

Alternatively, you can click on the Refresh icon, or select Refresh from the View menu 
for a nearly instant update.  

Still, most Administrators search for a comfortable Refreshment period which is short 
enough to ensure timely data but long enough to keep listings manageable. Achieving just 
the right interval requires a little experimentation. 

The Change Timeout dialog lets you re-set the Job Monitor’s clock. 

9 To access this dialog, press the Clock icon on the toolbar or select Change Timeout 
from the Refresh sub-menu of the Record menu. 
 

   

 
                                                        Change Timeout Dialog 

The fields and buttons of the Change Timeout dialog include: 

Field/Button Description 

Current Timeout: n 
Minutes 

The number of minutes between updates of the Batch 
Information Table…the Refreshment period. 

You can enter a new value directly or use the arrows to select a 
value. 

Current Timeout: n 
Seconds 

The number of seconds in the Refreshment period.  

Click here. 
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 Change Timeout Dialog (continued)  
Field/Button Description 

OK Button Confirms a change to the Minutes or Seconds of the 
Refreshment period (or both), and updates the clock. 

Cancel Closes the Change Timeout dialog without changing the 
Refreshment period. 

 

 
Multiple Job Monitors  - with different Refreshment Periods 

To change the amount of time between automatic updates of the Job Monitor’s Batch 
Information Table, take these steps: 

Step Action 

1. Select Refresh from the Record menu, and Change Timeout from the 
Refresh sub-menu…or press the Refresh icon on the Taskmaster Window 
Toolbar. 

2. If the revised Refreshment period will last long than 60 seconds, enter the 
number of Minutes. 

3. If the Refreshment period will be less than a minute or will be n minutes plus 
n seconds, enter the number of Seconds. 

4. Click on the OK button. 

( Alert! If you do change the Refreshment period, be sure to inform everybody who has 
access to the Job Monitor about the new timing. Remember, too, that the Job Monitor 
and Batch Selection dialog employ the same Refreshment period. (Chapter 4 examines 
all facets of the Batch Selection dialog.) 

If you set up multiple Job Monitors, each can have a different Refreshment period (Page 
60). 
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Job Monitor Filter 
Taskmaster’s Job Monitor is a powerful tool: informative, helpful and reliable. 

In a busy operation, however, the Batch Information Table grows quickly and, until you 
learn how to control its size, can be overwhelming.  

Two procedures help manage the scope of the Batch Information Table: 

Filtering uses search parameters you supply to find and display only those records 
which meet your criteria. This section examines the Job Monitor’s Filtering 
mechanism.    

AutoDelete automatically deletes Batch Transaction Records (and the batches they 
represent), according to a schedule you define. In most cases, these are batches with a 
Job Done status: Taskmaster has successfully exported their data, and the batches are 
no longer needed. For a full explanation of the AutoDelete utility, see the Taskmaster 
Administrator’s Guide. 

A third procedure can help, too. The View menu’s Find and Find Again options search 
the Batch Information Table, looking for Batch Transaction Records with an identifying 
code or title you supply. For more about this procedure, see Page 44. 

To use the filter, open the Job Monitor by clicking on its toolbar icon. Then, take one of 
these steps to access the Job Monitor Filter: 

• Select Filter from the View menu; or 

• Use the Ctrl + R keyboard combination; or 

• Click on the Filter icon in the toolbar.   

 
Job Monitor Filter 
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The top half of the Job Monitor Filter presents selection criteria you can use 
independently or in combination to isolate the listings you want. There are three sectors: 

Category is a field with five tabs. Each tab holds processing options; within a tab, 
you can choose one or more options as selection parameters.  

Batch lets you specify a Batch ID as your criteria or enter a “wildcard” value to 
select a range of batches. 

Time Range limits the scope of the Batch Information Table to Batch Transaction 
Records with a Job Start or Task Start within a period you designate. 

The Filter’s middle portion displays the parameters you’ve selected from tabs of the 
Category area. 

Along the bottom row are three actions buttons (Show All, OK and Cancel), and a SQL 
button leading to the SQL Server field. This field contains the filtering “expression” 
Taskmaster will use to find and display the records you’ve asked for.  
 

 

Batch 

      Processing  
      Categories 

Time 

  Filter   
  Parameters 

Job Monitor Filter 

 The table at the top of the next page describes the fields and functions of the Job 
Monitor Filter. 

9 The Job Monitor Manager employs an identical filtering mechanism. See Page 60 for 
details.  
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Job Monitor Filter 
Field/Function Description 

Category Area The five tabs of this sub-dialog list parameters that 
closely reflect the structure of your application, and of 
the job and task components of its workflows. 

When you select an item from a tab in this area, it 
appears in the Filter Parameters area and as an element 
in a SQL Server expression.   

Alert! To remove a parameter from the Filter 
Parameters area, hold down your  Ctrl key and select 
the item. 

      Jobs A list of Job IDs for all jobs in all workflows throughout 
the application. 

Selection of a Job ID limits the listings in the Batch 
Information Table to those with this value as the job 
component in the Job.Task field (Page 6).  

You can, however, select multiple jobs.  To select a 
second (or third or fourth!) job, hold down the Ctrl key as 
you move from Job ID to Job ID. 

      Tasks A list of all Task IDs representing all tasks assigned to all 
jobs in the application. 

You can select one task or, using your Ctrl key, select 
multiple tasks. 

If you select a task but do not select a job, the table will 
list all Batch Transaction Records with that Task ID in 
the Job.Task column. 

If you select a Task ID in combination with a Job ID, the 
table will contain listings with that Job/Task 
Combination only. 

Similarly, selecting a Task ID (or Job ID) with any other 
parameter automatically limits the scope of the table to 
listings satisfying both criteria. 

      Stations A list of workstations formally authorized to process the 
jobs and tasks of this application. 

Station IDs may appear in the Station column of the 
Batch Information Table (Page 9 and Page 37). 

      Users A list of individuals authorized to process the jobs and 
tasks of this application. 

User IDs may appear in the Op column of the Batch 
Information Table (Page 9 and Page 41). 
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Job Monitor Filter (continued)  
Field/Function Description 

Category Area (continued)  

      Status A list of all active Batch Statuses. 

These include: Aborted, Batch Stopped, Canceled, 
Deleted, Finished, Hold, Job Done, Off Line, Pending, 
Running and Waiting. 

Alert! Status is a critical batch attribute. Using Batch 
Status as a filter can generate a list with exceptional 
focus and usefulness. For definitions of the Batch 
Statuses, see Page 30. 

Batch ID Search and selection parameters: Batch IDs. 

You can use this field alone, or in company with other 
criteria, to identify the Batch IDs of listings that are to 
appear in the table. 

In an extreme case (for testing, perhaps), you could enter 
one Batch ID and press the OK button. The resulting 
table would contain the record for that batch only. 

If, instead, you were to use the % symbol to enter a 
wildcard value such as 

                   20000130% 

Taskmaster would list all batches with Batch IDs starting 
with “20000130.”   

Time Range Area Date and Time information that the Filter can use as 
selection criteria  (Page 44): 

JStart indicates the Time and Date on which a job 
began processing a particular batch. 
TStart indicates the Time and Date on which a task 
began processing a particular batch. 

The fields in this area allow you to specify a range of  
dates and times. As a result, the table will contain only 
Batch Transaction Records with Job Starts or Task Starts 
within the period. 

Note: These criteria can be especially effective in 
combination with Job and Task selections from the 
Category area (above). 
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Job Monitor Filter (continued)  
Field/Function Description 

Time Range Area (continued)  

      Mode Three options: 
None: Does not permit Date and Time criteria. 
Task Start: Uses the From and Until fields to 
designate a Task Start period to be covered by the 
table.  
Job Start: Uses the From and Until fields to 
designate a Job Start period to be covered by the 
table.  

      From Date and Time of the beginning of the period. 

This field is active only if Task Start or Job Start is the 
Mode (above).  

      Until Date and Time of the end of the period. 

Again, this field is active only if Task Start or Job Start 
is the Mode (above). 

Filter Parameters Area This area displays criteria you’ve selected from the tabs 
of the Category area above. 

In the example below, values in this sector direct the 
Filter to select those batches being processed by the 
Standard Main job, with a Pending status. 

 

 
Job Monitor Filter – Date parameters 
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Job Monitor Filter (continued)  
Field/Function Description 

Show All button Removes all settings of the Job Monitor Filter. 

SQL button Displays the SQL command containing the filter’s 
selection criteria. 

Taskmaster will use this command to generate the 
filtered Batch Information Table. If you are familiar and 
comfortable with SQL, you can use this field to sharpen 
the Filter’s focus.   

The button becomes a “Back” button after the SQL 
command line appears. 

OK button Uses the parameters you’ve specified to filter the content 
of the Job Monitor’s Batch Information Table.   

Cancel Closes the Filter without taking any action. 

   

 

      SQL 
      command 

Job Monitor Filter 

9 The next page outlines the steps you can take to limit the scope of the Batch Information 
Table. Be sure to experiment freely with different parameters, alone and in combination. 
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How to Use the Job Monitor Filter 
To filter the content of the Job Monitor’s Batch Information Table, take these steps: 

Step Action 

1. Review the table’s unfiltered content to decide selection criteria you can use 
to generate one more filtered lists of Batch Transaction Records. 

2. Select Filter from the View menu, or click on the Filter icon: the Job 
Monitor Filter will appear on your screen. 

3. If your selection parameters include an item from a tab of the Category area, 
click on the applicable tab, then on the item. Be sure that the item appears as a 
Selected Value next to the category’s listing in the Filter Parameters area. 
(Remember: Use the Ctrl key to select multiple items from the same tab.) 

4. Repeat Step # 3 for criteria in any other Category. 

5. To specify Batch ID criteria, enter a portion of a Batch ID followed by “%”. 
This will limit the number of Batch Transaction Records in the table to those 
that fall within this range. 

6. To include Date and Time criteria, select Task Start or Job Start from the 
Mode drop-down list in the Time Range area. Enter Dates and Times in the 
From and Until fields. 

7. Review the criteria in the Filter Parameters area. 

8. If you wish, press the SQL button for a look at the SQL command that will 
filter the table. 

9. Click on the OK button to generate the filtered Batch Information Table. 
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Batch Status 
In the illustration below, batches have a variety of processing statuses. 

Those with a Pending status are waiting to be processed by the Job/Task Combination 
indicated in the Job.Task column.  

One batch with a Job Done status because the Main Job’s Export task  and all preceding 
tasks have successfully  processed the batch. 
 

 

Aborted! 

Job Monitor 

The Aborted status for Batch 20040292.003 reveals a problem.  

Often, a task aborts because of mechanical difficulty. Perhaps the scanner has jammed. 
There’s little you can do to help a batch in this kind of trouble: you’re probably best off 
re-scanning the forms, creating a new batch and deleting the old. 

In other circumstances, the outlook may not be so grim. Suppose a batch aborts when a 
Look-up database becomes temporarily unavailable. As soon as the database is back in 
place, the Administrator can change the status of the batch from Aborted to Pending, and 
Taskmaster can resume processing. 

Before reviewing the steps an Administrator or Supervisor takes to change a Batch 
Status, spend a moment with the meaning of each status and its impact on a batch in the 
workflow. 
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SSTTAATTUUSS  EEXXPPLLAANNAATTIIOONN  

Pending Taskmaster automatically assigns this status when a batch 
has been successfully processed by the workflow’s previous 
task, and is ready to be processed by the task identified in 
the Job.Task column. Once a workflow is running 
smoothly, most batches carry a Pending status. 

Running This interim status appears briefly in the Taskmaster 
Window to indicate that the task is indeed processing the 
batch. 

Waiting When a batch is diverted from a task in the Main workflow 
to the task(s) of a child job, the Job Monitor’s Batch 
Information Table lists two Batch Transaction Records. One 
identifies the Job/Task Combination of the Main (parent) 
job and assigns Waiting as the Batch Status. The other 
identifies the applicable Job/Task Combination of the child 
job and specifies Pending as the Batch Status.   

Finished Taskmaster uses this status to mark the successful 
completion of a task’s work with the batch. When the Task 
Operations Message Page announces Batch Completion 
(Chapter 4), the wording of the message indicates a 
Finished status. This status shows up only briefly, however, 
in the listings of the Batch Information Table.  

Job Done Taskmaster assigns this status when a batch reaches the end 
of a job…either a parent job or a child job. In the case of a 
child job, this status indicates that the batch is ready to 
return to the parent job (usually, a Main job.) 

Hold Hold is a transition status assigned by an operator, 
Supervisor or Administrator, to halt processing temporarily. 
When placing a batch on Hold status, Taskmaster enters the 
individual’s User ID in the Op field of the Batch 
Transaction Record. Until the Batch Status changes, only 
this user can resume processing the batch.  

Aborted An Aborted status can result from the automatic 
intervention of Taskmaster, or from the manual intervention 
of an operator. The status alerts you to a problem of 
considerable importance: a job cannot process a batch with 
an Aborted status. 

Batch Stopped If an application uses a task such as Recognition to split a 
primary batch into secondary batches, the task will assign  
Batch Stopped to the primary batch. This step immediately 
halts the processing of the primary batch.  

Cancelled A Scan task operator assigns this status when terminating a 
batch prematurely. Taskmaster then changes the status to 
Aborted. 
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SSTTAATTUUSS  EEXXPPLLAANNAATTIIOONN  

Deleted The Deleted status reminds you that you have deleted the 
Image files associated with a batch but have not removed 
other files (such as Page files) and the batch itself. For more 
about deletions, see Page 46.  

Off Line This status indicates that Taskmaster is unable to connect 
with the drive holding the applicable Batches directory. 

Changing the Status of a Batch…or its Task 
Batch Status serves as an essential indicator of the condition of a batch as it completes 
one task and moves to the next. After a workflow is firmly in place, you’ll have little 
reason to change a status manually. In most cases, problems that surface will require an 
investigation of the batch and its contents rather than of the workflow’s jobs and tasks. 

During installation and testing, however, you’ll have numerous opportunities to change 
the status of a batch–or even “roll back” the batch to a previous task. Some applications 
employ tasks that abort batches automatically if they cannot find the correct look-up table 
for internal validation procedures. This sort of disruption is likely to occur, if it occurs at 
all, during the implementation and testing of a new Taskmaster application.   

Let’s assume again that once the look-up table is back in place, the Administrator is 
going to test the updated procedures, using the Aborted batches as sample transactions. 
But because Taskmaster cannot process an Aborted batch, the Administrator will rely on 
the Status Change/Rollback dialog to assign a new status to each Aborted batch (see the 
illustration on the opposite page). 

( To access this dialog, double-click in the Status field of the applicable Batch Transaction 
Record, or select Status Change/Rollback from the Record menu (Ctrl + R). The 
dialog’s fields and functions include: 

Field/Function Description 

Batch ID The identifying code of the batch you have selected. 

Queue ID The Queue ID assigned to the batch during scanning. 

Tasks A drop-down list containing the current task and all tasks 
preceding this task in the job. 

You can use this field to assign a different task to the batch, 
and thus roll back the batch to an earlier stage in the job. 

Statuses A drop-down list of Batch Statuses (described above). 

Selecting a status and pressing the OK button assigns a new 
status to the batch. 

OK button Confirms the settings in the fields above and closes the dialog. 

Cancel button Closes the Status Change/Rollback dialog. 
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To change a Batch Status or roll back the batch to an earlier task, take these steps: 

Step Action 

1. Select the applicable Batch Transaction Record from the Job Monitor’s Batch 
Information Table.   

2. Double-click in the listing’s Status field or select Status Change/Rollback 
from the Record menu to retrieve the Status Change/Rollback dialog. 

3. To assign an earlier task to process the batch, select the task from the Tasks 
drop-down list. 

4. To provide the batch with an acceptable processing status (usually Pending),  
select the status from the Statuses drop-down list. 

5. Press the OK button. 

6. When the Message Pad asks “Are sure you want to change the selected 
entries?” press the Yes button. 

7. After a pause, Taskmaster will update the listing. Be sure that the data is 
correct. 
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Batch Attributes 
In the illustration below, Batch 20040293.024 has completed the Verification process and 
is ready for the Export task of the 1040EZ application’s Main Job (Main Job.Export). 
  

 
Job Monitor 

If you were to double-click in the listing’s Batch ID field, the Batch Attributes dialog 
would appear with the information below. (Alternatively, you could highlight the listing 
and select Batch Attributes from the Record menu.) 
 

 
Batch Attributes Dialog 

( This dialog contains key batch specifications and allows you to modify those 
specifications. Before you make a change, however, be sure to consider its full impact. 
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The table below describes the fields and functions of this dialog. 

Field/Function Description 

Batch ID The unique identifying code assigned to the batch. 

You can enter a new Batch ID. However, be careful that you 
do not use an ID assigned to another batch. 

Parent Batch ID If the batch you’ve selected is a segment of a larger batch 
and has been split from a parent job’s batch, this field 
identifies the “parent” batch. 

Batch Directory The location of the batch and its files. 

Sometimes, when you are setting up and testing a new 
application, a task will be unable to find a batch in the 
location you’ve specified in the Task Definition. One short-
term solution is to use this field to update the address of the 
batch. 

Keep in mind, however, that this is a remedy for one batch 
only. The underlying problem is probably pervasive and 
needs a more basic solution.  

Page File Name The name of the Page file (.xml) generated by the last task to 
process the batch. 

If you rollback a batch for processing by a task earlier in the 
workflow (Page 32), you’ll use this field to identify the Page 
file generated by the previous task. 

For a full explanation of rollback procedures, see the 
Workflow Development and Operations Manual. 

OK button Confirms any changes you’ve entered in the Batch 
Attributes dialog, and closes the dialog. 

Cancel button Closes the Batch Attributes dialog without saving changes. 

 

9   Be careful: Only a few circumstances justify changes to specifications in the fields of the 
Batch Attributes dialog. Before making such changes, consult Datacap Support or your 
Datacap Implementation Specialist. 
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Batch History 
For a look at the same batch from an historical perspective, you could highlight the 
record and select Batch History from the Record menu, press the Ctrl + H keyboard 
combination, or double-click in the listing’s Job.Task field  
 

                                                  Batch History Dialog 

This is an information-only dialog: its table outlines the progress of the batch through 
workflow, right up to its current position. 

As you can see, the batch above has successfully negotiated four out of five tasks in the 
Main Job; the last row is almost empty because the job’s Export task has yet to begin its 
work. 

Information in the Batch History dialog includes: 

Data Description 

Row ID The number of a row in the Batch History Table, often 
corresponding to the position of a task in the workflow.  

Task ID The identity of a task that has processed the batch or is next in 
line. 

The listing does not include a Job ID because all tasks in the 
table belong to the same job. 

Station ID The identifying code of the workstation running the task. 

Page 5–36 Confidential and Proprietary Information of Datacap Inc. 
 Copyright © 2005 Datacap Inc. 



Chapter 5: Job Monitor and Station Monitor 

Batch History Dialog (continued)  
Data Description 

Operator The User ID of the operator responsible for the task when it 
processed this batch. 

Start Time The task’s starting Date and Time. 

Tsec The number of seconds the task has spent on the batch. 

OK button Closes the Batch History dialog. 

 

Changing Operator, Station and Priority Values 
The Change Operator/Station/Priority dialog lets you change three properties of a batch 
you’ve selected from the Job Monitor’s Batch Information Table: 

• You can raise or lower the Priority rating the Scan task assigned (Chapter 4). 

• You can assign or re-assign an Operator to a batch – or remove an Operator 
assignment. 

• You can assign or re-assign a Station to the batch  - or remove a Station 
assignment. 

9 In addition, fields in the Unavailable for section at the bottom of the Change 
Operator/Station/Priority dialog oversee any Operator and Station values that result 
from a Task Definition’s Queue to and Store properties. 

To access this dialog, double-click in a listing’s Op, Pr or Station field, or highlight the 
batch and select Change Properties from the Record menu (Ctrl + P on your keyboard). 

The illustration on the next page is revealing because it lists a Priority value for every 
batch – probably a default value that is a property of the Main Job’s Job Definition and 
has been picked up by each task (Chapter 6).  

Only one batch that you can see has Op and Station values. This is because the batch has 
a Hold status. This batch can be run only by the operator that placed the batch on Hold, 
from the same station, unless you use the Operator/Station/Priority dialog to intervene 
and change the Op and Station values.  

 

Confidential and Proprietary Information of Datacap Inc. Page 5–37 
Copyright © 2005 Datacap Inc. 



Changing Operator, Station and Priority Values 

    Change Operator/Priority Dialog  

 
Operator and Station settings in the dialog’s Assigned area determine which operator 
and workstation must run the listing Job/Task Combination when it processes the current 
batch. In the example above, the Administrator is re-assigning this responsibility to the 
edit1 operator. 

The Operator and Station settings in the dialog’s Unavailable area prevent a particular 
operator or station – or both – from launching the Job/Task Combination.  

 

9 Very important! Above, listings for the batches in line for the TestTasks job’s 
Recognize task have Op and Station values even though they are Pending batches. These 
values, which require processing by the Admin Operator and Station 1 are not the result 
of a Status such as Hold. They result, instead, from the Store setting of the vScan Task 
Definition and the Queue to setting of the Recognize Task Definition. Page 42 explains 
these settings. 
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In the illustration on the previous page, Batch 20040295.001 has two values with unusual 
formats. [admin] in the Op column and [1] in the Station column mean that both 
the Admin user and the “1” station are restricted from launching the TaskTest.Verify 
Job/Task Combination for this batch. These restrictions have been put into place in the 
Unavailable section of the Change Operator/Station/Priority dialog. 

Processing Priority is a property of a Job Definition (Chapter 6) and its value becomes a 
default (but hidden) property of each of the job’s tasks. The Change 
Operator/Station/Priority dialog let’s you change the value for the Job/Task 
Combination when it is processing the current batch. Priorities range from “10” (Low) to 
“1” (High); “5” is Taskmaster’s default. 
 

The table below describes the fields and functions of this dialog: 

Field/Function Description 

Batch ID The identifying code of the batch you highlighted in the Job 
Monitor’s Batch Information Table. 

Queue ID The placement of the batch in the overall processing queue. 

Remember (1): the Scan task assigns this placement when it 
creates the batch. 

Remember (2): Taskmaster’s batch selection procedures look 
first for batches with a certain Priority classification, then at 
the sequence of Queue IDs within that classification.   

Assigned area  

Operator A drop-down list showing the User IDs of all individuals 
authorized to carry out the application’s tasks (Chapter 6). 

A User ID typically appears in a listing’s Op field when an 
operator (or Supervisor or Administrator) has intervened to 
abort the batch or put it on Hold temporarily–or when the 
batch completes the workflow of a job or child job.  
Alternatively, the Op field will include a value in response to 
a combination of a Queue to value in the definition of the 
current task, and a Store value in the definition of a previous 
task (Page 42).  

If the Op field does not contain a value, this drop-down list 
will display <None>. 

When you use this field to designate a different operator, only 
that operator can access the batch until the batch has 
completed the task at hand.     
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Change Operator/Station/Priority dialog (continued)  

Field/Function Description 

Station A drop-down list showing the Station IDs of all workstations 
authorized to carry out the application’s tasks (Chapter 6). 

A Station ID typically appears in a listing’s Station field 
when an operator (or Supervisor or Administrator) has 
intervened to abort the batch or put it on Hold temporarily–or 
when the batch completes the workflow of a job or child job.  
The Station field can include a value in response to a 
combination of a Queue to value in the definition of the 
current task, and a Store value in the definition of a previous 
task (Page 42).  

If the Station field does not contain a value, this drop-down 
list will display <None>. 

When you use this field to designate a different station, only 
that station can access the batch until the batch has completed 
the task at hand.       

Priority The Priority classification assigned to the batch during 
scanning. 

“10” = Low; “1” = High; “5” is the default. Raising this 
number lowers the Priority of the batch.  

Unavailable for area  

Operator  A drop-down list showing the User IDs of all individuals 
authorized to carry out the application’s tasks (Chapter 6). 

When you select a User ID and click on the dialog’s OK 
button, Taskmaster adds enters a value such as [edit1] in 
the listing’s Op field. This prevents that user – edit1, in this 
case – from launching the current Job/Task Combination to 
process the batch.  

Station A drop-down list showing the Station IDs of all individuals 
authorized to carry out the application’s tasks (Chapter 6). 

When you select a Station ID and click on the dialog’s OK 
button, Taskmaster adds enters a value such as [1]in the 
listing’s Station field. This prevents that user from launching 
the current Job/Task Combination to process the batch. 

OK button Saves new settings and closes the dialog. 

Cancel button Closes the Change Operator/Priority dialog. 
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To Change Operator and Station Assignments – or Set a Priority 
Classification 

To assign a particular operator and/or station to a particular batch listing - or to modify its 
Priority rating - take these steps: 

Step Action 

1. Highlight the batch in the Job Monitor’s Batch Information Table. 

2. Double-click in the listing’s Op, Station or Pr field: the Change 
Operator/Station/Priority dialog will appear on your screen.  

3. To specify an operator that must run the current batch, select a value from the 
Operators drop-down list in the dialog’s Assigned area. 

4. To specify a workstation from which the current batch must be launched, 
select a value from the Operators drop-down list. 

5. To modify a Priority classification, enter a new value in this field. 

6. Review your settings. 

7. Press the OK button. 

8. Confirm the changes in the listing in the Batch Information Table. 

9. To prevent a particular operator from launching the Job/Task Combination 
that’s next in line to process the batch, select an Operator in the Unavailable 
for area. 

10. To prevent a particular workstation from launching the current batch, 
launched, select a Station.  

11. Press the OK button at the bottom of the dialog; confirm your additions and 
modifications in the Batch Information Table.  

9 Entries (without brackets) in the Op and Station columns require the involvement of a 
specific user and workstation. These values appear automatically if, at the conclusion of 
processing by the previous Job/Task Combination, Taskmaster assigned a Hold status to 
the batch. 

A value will also appear in one or both columns if the Task Definition of an earlier task 
contains parameters that combine with parameters established by the Task Definition of 
the current task. Together, these Store and Queue to parameters determine which 
operators and stations can run the current task when it processes the current batch.   

Alert!  The mechanics of the task’s Store and Queue to properties can have a significant 
impact on an application’s batch processing. Be sure to review the explanations of these 
properties on the following page. 
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STORE and QUEUE TO Properties of a Task Definition 
 The Store and Queue properties of a Task Definition determine which operators and 
workstations can process individual batches.  

9 The Store property looks forward; the Queue to property looks backwards.  

In the first illustration below, the definition of the 1040EZ application’s VScan task 
specifies Station as its Store value. The definition of the Recognition task in the second 
illustration indicates by Station as its Queue to property.  

The Store property of the VScan task means that the batches it produces can only be 
processed by future tasks launched from the same station. The Queue to property of the 
Recognition task (in this example) limits that task to batches previously processed by the 
same station and operator. These restrictions will appear in listings of the Batch 
Information table. 

 

Store value 

Taskmaster Administrator – Workflow tab 

 

Queue to  
 values 

Taskmaster Administrator – Workflow tab 

In the Workflow tab of the Taskmaster Administrator - the Queue to and Store fields 
are drop-down lists that display their values when you click once on the field. The table 
on the next page lists and explains these options. 
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Store… Î Queue… Í Explanation 

“None” or “Station ID 
and User ID” 

“None” The None value allows any operator and 
Station ID to process batches in the task’s 
queue – and thus overrides the Station ID and 
User value assigned to an earlier task’s Store 
property. 

“Station ID” or “Station 
ID and User ID” 

“by Station” The task can process only those batches 
previously processed from the same 
workstation ID. 

“UserID” or “Station ID 
and User ID” 

“by User” The task can process only those batches 
previously processed by the same operator. 

“Station ID” or “Station 
ID and User ID” 

“by Other Station” The task can process only those batches 
previously processed from a different 
workstation ID. 

“Station ID and User 
ID” 

“by Station and User” The task can process only those batches 
previously processed by the same operator, 
from the same workstation ID. 

“Station ID and User 
ID” 

“by Station and  other 
User” 

The task can process only those batches 
previously processed by a different operator, 
from the same workstation ID. 

“Station ID and User 
ID” 

“by User and Other 
Station ” 

The task can process only those batches 
previously processed by the same operator, 
from a different workstation ID. 

“Station ID and User 
ID” 

“by other Station and 
other User ID” 

The task can process only those batches 
previously processed by a different operator, 
from a different workstation ID. 
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Finding Records 
The Job Monitor’s Find dialog is helpful but limited: you can find a single Batch 
Transaction Record almost instantly by entering a parameter from one column of the 
Batch Information Table, and by using the Find items in the View menu. 

In the simplified example below, a Datacap HCcs Administrator is looking for the sub-
batch that the AutoRouter task broke off from Batch 2000119.003 and sent to the 
QExport child job. 
 

 
                                  Find Dialog   

To conduct the search, you begin by selecting a Starting point–either an individual field 
in a Batch Transaction Record, or an entire column - then select Find from the View 
menu. (To highlight a column, click on the column’s Title field. The Find procedure 
looks for a match in this column only.) In the example, the procedure uses a Batch ID 
value to find the record in Row 28. 

The fields and functions of the Find dialog include: 

Field/Function Description 

Find What A value that serves as a search parameter. 

To be effective, the value must include at least a portion of the 
value in a target field of the column.  

Match Case A check box which, if activated, directs Taskmaster to include 
Upper Case and Lower Case letters as selection criteria.    

      Target 
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Find Dialog (continued)  
Field/Function Description 

Direction Options indicating if Taskmaster is to look for a match in the fields 
above or below the Starting Point. 

This is a required specification: you must make a choice.  

Find Next button Initiates the search for the next incidence of the value you’ve 
entered in the Find What field.  

Cancel button Closes the Find dialog without initiating a search. 

 

To Search for a Batch Transaction Record 
To search for a record in the Batch Transformation Table, take these steps. 

 Step Action 

1. Place your cursor in a field of the column you intend to search. This is your 
Starting Point. (To search the entire column, click on the column’s Title field 
to highlight all fields in the column.) 

2. Select Find from the View menu to access the Find dialog. 

3. Enter a search parameter in the Find What field. 

4. To be sure Taskmaster matches Upper Case and Lower Case characters as 
part of the search, select the Match Case option. 

5. Indicate if the Direction of the search is to be Up or Down from the Starting 
Point. 

6. Press the Find Next button. 

9   To conduct a second search from this point, with exactly the same parameters, select 
Find Again from the View menu. 

Table Navigation 
After you select a Starting Point - a single field in a column or the entire column - you 
can use the Navigation items of the Record menu to move about the Batch Information 
Table: 

• First Record takes you to Row 1 of the Batch Information Table. 

• Previous Record moves you up one row. 

• Next Record moves you down one row. 

• Last Record takes you to the table’s final record. 
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Deleting a Batch  
Taskmaster’s AutoDelete utility regularly and accurately removes batches and their files 
from an application’s Batches directory, and the associated Batch Transaction Records 
from the Job Monitor’s Batch Information Table. (   

For the most part, these batches have completed the workflow: the data in their 
documents has been verified, validated and exported. According to instructions you 
provide, AutoDelete can automatically remove other batches as well…those with an 
Aborted status and no recent activity, for example. 

You can also use the Job Monitor to delete a batch and its contents from the application’s 
Batch Directory. This extreme step can be helpful when you are installing and testing 
your Datacap system or setting up an application. Once an application is up and running, 
however, using the Job Monitor to delete a batch can be disruptive. 

9   Warning! We strongly recommend that you do not use the Job Monitor to delete batches 
after an application has completed its testing cycle and is firmly in place. Chapter 7 of the 
Taskmaster Administrator’s Guide explains all aspects of the AutoDelete utility. 

 

 

             Delete 

        Taskmaster Window – Job Monitor Deletions 

The “deletion” of a batch from the Job Monitor occurs when you select Delete from the 
Record menu. However, there are two possible results – Taskmaster’s action depends on 
your response to one of the two options in the Deleting Batch(es) dialog, depicted on the 
next page.        
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Deleting Batch(es) Dialog 

If you click on the first option and press the Yes button, Taskmaster will deliver the 
message below.  

If you then respond to this inquiry by clicking on the Message Pad’s OK button, all files 
associated with the batch will be removed from the Batch Directory. This measure also 
deletes any trace of batch statistics from the application’s Engine database. 
 

 
Message Pad – Batch Deletions 

On the other hand, if you select the lower option, Taskmaster will simply remove the 
listing from the Job Monitor’s Batch Information Table, leaving the batch folder intact. 

9 Important! Taskmaster will not remove the files and statistics of a batch waiting for 
processing by a child job such as FixUp job. You can, however, removes the batch listing 
from the Batch Information Table. 
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To use the Job Monitor to delete a complete batch, or a batch listing, take these steps: 

Step Action 

1. Highlight the target batch(es) in the Job Monitor’s Batch Information Table. 

2. Select Delete from the Record menu: the Deleting Batch(es) dialog will 
appear on your screen. 

 

3. To remove the listing(s) from the Batch Information Table only, select the 
lower Delete Job Monitor Records Only option and press the Yes button. 
Alert! This is an irreversible step; you receive no further warning. 

4. To confirm the removal of the listing, click on the toolbar’s Refresh icon; 
Taskmaster will immediately update the Batch Information Table. 

5. To completely delete a batch and all its files, select the batch and the Delete 
Job Monitor Records and Files option. Click on the Yes button. 

6. When the Message Pad asks if “you want to continue,” click on the OK 
button. 
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Adding Custom Columns to the Job Monitor  
Information from the Queue table of your application’s Engine database combines with 
information from the TMBatch table to form a row in the Job Monitor’s Batch 
Information Table. 

In Taskmaster, you can add a column to the Batch Information Table and, consequently, 
a field to each row. You can add one column or many – as long as you first add a 
corresponding source column to the TMBatch table of the Engine database. 

In the illustration below, the Administrator of the Survey training application has added a 
Supervisor column to the Batch Information Table. (This example uses the View menu’s 
Freeze Columns option to move the new column and its values close to key identifying 
columns such as Queue ID and Batch ID.)    
 

 
Job Monitor - with Custom Column (“Supervisor”) 

The fields in the column are interactive: an operator, Supervisor or Administrator with 
the appropriate credentials (Page 4) can enter data directly into a field. These fields can 
also display a default value you assign when you define the custom column. 

9 As a first step, be sure to close your Taskmaster application. 

Then, using your Microsoft Access or SQL Server interface, open the TMBatch table of 
your application’s Engine database.  

You can then follow up with the steps outlined on the next page. 
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To Define a Custom Column for the Job Monitor 

Step Action 

1. Use the applicable Access or SQL Server procedure to insert a new column in 
the TMBatch table. (The examples below depict an Access database.) 

2. Rename the column using a “pb_” prefix. (Later, the Job Monitor will drop 
the prefix from the column’s title.) 

 

       Properties 

3. For an Access database, click on the Design icon to retrieve the table’s 
properties. Confirm these settings: Data Type = Text; Required = No; Allow 
Zero Length  = Yes. 

4. Save the table. 

5. For a SQL Server database: 

Confirm that the column’s Data Type is varchar and select Allow Nulls.  
 
In the Enterprise Manager, highlight JMView in the View section of 
your database. Right-click and select the Design View option to access  
the Design window. Run the view by clicking on the ! icon. Click on the 
Save icon, then exit the window by clicking on the Close icon. 
 
Next, highlight JobMonitor in the View section of your database. Right- 
click and select the Design View option to access the Design window. Run 
the view by clicking on the ! icon. Click on the Save icon, then exit the 
window by clicking on the Close icon.  

6. Check the TMBatch table to be sure the new column is in place. 

7. Open your Taskmaster application.  

8. Select Users from the Settings menu to access the Users tab of the 
Taskmaster Administrator.  Confirm that those who will be using the Job 
Monitor have the appropriate security Privileges (Chapter 6). 
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To Add a Column to the Job Monitor (continued)  

Step Action 

9. Be sure that the User Definitions of individuals who can enter or modify data 
in the fields of the new column include the Custom Field’s Properties 
Change privilege (shown below). 

 

Select this 
privilege. 

10. Click on the Apply and Done buttons at the bottom of the Taskmaster 
Administrator. 

11. Run your application in Test Mode to create a sample batch, and a new listing 
in the Job Monitor. 

12. Confirm that the Batch Information Table includes the custom column and 
that the new listing displays a default value, if applicable.     

13. To enter a value, double-click on the field to retrieve the Custom Field 
Properties dialog. Remember: Only a previously authorized user can access 
this dialog.  

 

 

 

Confidential and Proprietary Information of Datacap Inc. Page 5–51 
Copyright © 2005 Datacap Inc. 



Adding Custom Columns to the Job Monitor 

To Add a Column to the Job Monitor (continued)  

Step Action 

14. Check the dialog’s identifying data, then enter a Custom Field Value that 
conforms to the requirements of the Column Definition. 

15. Press the OK button to close the Custom Field Properties dialog.  

16. Click on the Job Monitor’s Refresh icon to update the field with the value 
you’ve entered. 

9 Additional considerations:  

If you are working with a SQL Server database, you must re-save two views in the 
Engine database - JMView and JobMonitor – after you have added a custom field to the 
TMBatch table: 

1.) Open the view in SQL Server’s Design mode. 

2.) Click on the Save icon. 

Within your Datacap directory, the Reports folder of the tm2000 sub-directory contains 
an Access database (base.mdb) used to generate certain reports (Page 57). When you add 
a custom column to the TMBatch table of Engine database, be sure to add the same 
column to the JobMonitor table of the base.mdb. 

( Taskmaster places few limits on the role of a custom field. Both SQL Server and Access 
offer a number of basic techniques you can use to refine the definition of a custom 
column, and the display and validation of its data.       
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Station Monitor 
Taskmaster’s Station Monitor provides Administrators and Supervisors with information 
about workstations with Taskmaster Clients that are currently connected to an 
application’s Taskmaster Server.    
 

 
Taskmaster Window–with Station Monitor 

Like the Job Monitor, a table forms the core of the Station Monitor. In this case, 
however, the table’s scope is more limited. The fields in a record of the Station 
Information Table include: 

Field Description 

Station ID A unique code which identifies the workstation. 

An Administrator assigns this required code when authorizing the 
workstation to process the application’s batches. 

User ID A unique code identifying the individual who has signed on to this 
Taskmaster application - from this workstation. 

Like the Station ID (above), the Administrator assigns the required 
User ID as part of the application’s Security Program (Chapter 6). 

Task The processing status of the workstation. 
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Station Information Table (continued)  
Field Description 

Job.Task The Job/Task Combination that the station is actively processing. 

For an explanation of Job/Task Combination. 

IP Address A network protocol “address” designating the station’s connection 
to Taskmaster Server.  

Port The “local” port on the workstation which maintains the connection 
to the server. 

Batches The number of batches that this workstation has processed since the 
user signed on. 

 

Menus and Toolbar Icons 
The Station Monitor and Job Monitor share menus and toolbar icons. For a description 
of each menu item, see Page 12. For explanations of the toolbar icons, see Page 19. 

However, if you look closely at the Taskmaster Window’s toolbar configuration on the 
previous page, you’ll see three unique icons. As defaults, the Station Monitor includes 
the magnification icons: 

 

The icons raise or lower the magnification of data in the Station Information Table, or 
display it at 100% of the default type size. 

In addition, the default structure of the Station Monitor toolbar configuration includes 
many of the administrative icons from the File category. For explanations of each icon 
and of the steps you can take to modify this configuration, see Chapter 3.  
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Formatting Tables 
The default format of the Job Monitor’s Batch Information Table looks something like 
this.  

 
Batch Information Table 

But anyone who is authorized to access the table can change the format, easily and 
repeatedly. In the example below, the Supervisor expanded certain key columns for a 
clearer view of their information. 

9 To change a column’s width, use your mouse to drag the column’s right edge one way or 
the other. 

 

However, when the Supervisor closed the Job Monitor, this message appeared: 
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She approved of the new format, so she clicked on the Message Pad’s Yes button: this 
retrieved a Save as dialog linked directly to tour application’s Process directory: 
 

 
Save  as… 

Taskmaster stores the Batch Information Table’s default formatting parameters in the 
jblayout.ogl file. To retain your new parameters: 

• Save the settings in a different .ogl file. 

• Click on the Save button. 

When you return to the Job Monitor, the new format will take over automatically. 
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Reports 
When the Job Monitor or Station Monitor is the active component of the Taskmaster 
Window, the File menu includes five items to help you format and generate reports. 
These reports extract, format and print the data in the Batch Information Table or the 
Station Information Table. 

( These menu items access standard Windows dialogs. The paragraphs below introduce the 
role of each dialog in report generation, but do not examine the details of their fields and 
functions. 

 
Taskmaster Window - File Menu 

Active Job Monitor

Header/Footer 

Going first to the last item in the list, the Header/Footer dialog gives you a chance to 
customize the background data that is to appear at the top of each page in the report 
(Header tab) or at the bottom (Footer tab).  

 
Header/Footer Dialog 
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Page Setup 

The settings of this dialog determine how the report will print the table’s information: 
 

 
Page Setup Dialog 

The Page Setup dialog has five areas: 

Margins. These measurements specify distances from the edges of the page to the 
edges of the report’s table. In the example above, the row with column titles (Row 
Headers) will begin 1.0” from the left side of the page, and 1.5” from the top of the 
page. 

Title and Gridlines. The settings in this area determine the appearance of the 
table…whether or not, for the example, the report will print the grid’s Vertical Line, 
Horizontal Line or both. When you select or de-select most options in this list, the 
Preview area displays the change. 

Page Order.  Even in Landscape layout (see the Print Setup dialog on the next 
page), a report with a full Batch Information Table cannot squeeze all columns onto a 
single, printed page. A required selection in this area decides if a report is to first 
print data from an initial set of columns and all rows on sequential pages, followed 
by a second set of columns and all rows, etc. This is the First Rows, then Columns 
option. Alternatively, you can direct Taskmaster to generate a report showing an 
initial set of rows and all columns on sequential pages, followed by the next set of 
rows and all columns, etc. This is the First Columns, then Rows option. 

Center on Page. These settings allow you to place the table in the middle of the 
printed page. At your direction, Taskmaster will find a midpoint from top to bottom 
(Vertical), side to side (Horizontal), or both. (To see different results, use the Print 
Preview menu item). 
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Preview. Displays the probable appearance of a report’s table in response to settings 
you select from the other areas.  

Print Setup 

This dialog sets up the printing mechanism by specifying a printer (really, a printer 
driver), and the type and location of the report’s paper.  The Properties button leads to 
another dialog: the structure and contents of this dialog change according to your 
selection of a printer driver. 
 

 
Print Setup Dialog 

Each edition of the Print Setup dialog asks you to make an important decision: you must 
specify whether the report is to be printed in Portrait layout (see the next page) or  
Landscape. 
 

Print Preview 

This easy-to-use tool shows you how a report will look when you actually print it. In the 
example below, the Administrator has selected a Portrait layout, and has centered the 
Batch Information Table horizontally on the page. In addition, to save a little space, the 
Administrator did not select the Row Headers option in the Titles & Gridlines area of 
the Page Setup dialog. 
 

Print 

This item (or the Ctrl + P keyboard combination) leads you right to the Windows Print 
dialog. Like the Print Setup dialog, the structure and content of this dialog depend on 
your selection of a printer driver from the Name drop-down list. 

Pressing the OK button of the Print Setup dialog prints the report you’ve probably 
previewed in the Print Preview dialog. 
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Job Monitor Manager 
You can establish and use multiple Job Monitors – each with a Batch Information Table 
that is filtered to display a unique set of data. 

For example, if certain stations are exclusively responsible for specific Job/Task 
Combinations, you might construct a distinct Job Monitor for each. You can then filter a 
monitor so it shows only listings for that station. 

Or, if your application features two, very different Workflow Hierarchies (Chapter 6),  
you could install two Job Monitors – one to list batches being processed by the jobs and 
tasks of Workflow A, the other for the batch listings of Workflow B. 

$ Although you can use the New Job Monitor and Filter dialog icons on the Taskmaster 
Window toolbar to construct multiple Job Monitors, we strongly recommend that you 
rely on the Job Monitor Manager instead. The Job Monitor Manager provides tools you 
can use repeatedly to: 

• Assemble multiple Job Monitors. 

• Provide each with a unique identity. 

• Provide each with a unique filter. 

• Determine the order in which individual Job Monitors will appear in the Data 
Area of your Taskmaster Window. 

• Delete Job Monitors that you no longer need. 

Important!  Contents of a Batch Selection dialog are not determined by the filtering 
parameters of a Job Monitor. Instead, this dialog relies on the selection properties of a 
Job-Task shortcut (Chapter 4) for its content. 
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Elements of the Job Monitor Manager 
9 To access the Job Monitor Manager, select Job Monitor Manager from the View 

menu. 

 
Job Monitor Manager 

The Job Monitor Manager’s Job Monitor Table contains the following information: 

• Available Job Monitors is a list of the Job Monitors you have defined - but 
have not deleted. The table displays the names you have assigned, and is ranked 
sequentially, according to the order in which in you set them up. Important! The 
Job Monitor at the top of the list is the default monitor. However, you can use 
the Rename button to provide it with a new title, and you can use the Move Up 
and Move Down buttons to revise the order and select a new default.   

• Status indicates the current status of a Job Monitor – and is either <blank> or 
Active.  

• Filtered specifies yes if the highlighted Job Monitor has been filtered (Page 23)  
or no if it has not. 

• Refresh Interval (sec) indicates the number of seconds between automatic 
updates of a highlighted Job Monitor ‘s Batch Information Table. Alert! To 
change this value, click once just to the right of the current value and enter a new 
value. 

• Extra Title Information uses the show or hide value you assign to determine 
whether the highlighted Job Monitor will display the Refresh Interval in its Title 
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Bar. To change this value, click once just to the right of the current value and 
enter a new value. 

The Job Monitor Manager features these buttons: 

Activate.  Places the Job Monitor you select from the table into the Data Area of the 
Taskmaster Window - and gives it an Active status. 

Close. Closes an active Job Monitor after you highlight its title in the Job Monitor 
Table. 

Close All. Closes all active Job Monitors. 

New. Creates a new Job Monitor but does not place it in the Data Area of the 
Taskmaster Window until you highlight its title and click on the Activate button. 

Delete. Deletes the Job Monitor you’ve highlighted in the Job Monitor Table. 
Important! Deleting a Job Monitor does not delete its batch listings. 

Rename. Isolates the value in the Available Job Monitors column of a highlighted 
Job Monitor so you can give the monitor a new name. Important! When you 
construct multiple Job Monitors, clear but distinguishing names are essential. 

Switch to. Brings the Job Monitor you select from the Job Monitor Table into the 
foreground of the Taskmaster Window’s Data Area. 

Move Up. Moves a highlighted Job Monitor one row higher in the Job Monitor 
Table. Important!  Job Monitors open the Taskmaster Window’s Data Area in the 
order in which they appear in the rows of the Job Monitor Table. The monitor which 
occupies the top row appears first when you click on the toolbar’s Job Monitor icon. 

Move Down. Moves a highlighted Job Monitor one row down in the Job Monitor 
Table. 

Filter. Opens the Job Monitor Filter dialog (Page 23). You can use this dialog to set 
up a filter for the monitor you’ve highlighted in the Job Monitor Table. 

Exit. Closes the Job Monitor Manager. 

9 The Job Monitor Manager is a powerful tool if you can benefit from more than one Job 
Monitor. Take time to practice setting up additional monitors and installing filters for 
each. 
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